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Abstract

Liang, Jingjing; Buongiorno, Joseph; Monserud, Robert A. 2004. CalPro: a spread-
sheet program for the management of California mixed-conifer stands. Gen. Tech.
Rep. PNW-GTR-619. Portland, OR: U.S. Department of Agriculture, Forest
Service, Pacific Northwest Research Station. 32 p.

CaPro is an add-in program devel oped to work with Microsoft Excel to simulate the
growth and management of uneven-aged mixed-conifer standsin California. Its built-in
growth model was calibrated from 177 uneven-aged plots on industry and other private
lands. Stands are described by the number of trees per acre in each of nineteen 2-inch
diameter classes in two species groups, hardwoods and softwoods.

CaPro alows managers to predict stand development by year and for many
decades from a specific initial state. Users can choose cutting regimes by specifying the
interval between harvests (cutting cycle) and a target distribution of trees remaining
after harvest. A target distribution can be a reverse-J-shaped distribution or any other
desired distribution. Diameter-limit cuts can also be simulated. Tabulated and graphic
results show diameter distributions, basal area, volumes, income, net present value, and
indices of stand diversity by species and size.

This manual documents the program installation and activation, provides sugges-
tions for working with Excel, and gives background information on CalPro’s growth
model. It offers a comprehensive tutorial in the form of two practical examples that
explain how to start the program, enter simulation data, execute a simulation, compare
simulations, and plot summary statistics.

Keywords: Mixed conifers, uneven-aged management, economics, ecology,
CaPro, simulation, software, growth model, diversity.
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CalPro: A Spreadsheet Program for the Management of California Mixed-Conifer Stands

I. Introduction

Welcome to CalPro—a spreadsheet program to help with management decisions
using uneven-aged systems in mixed-conifer forests. This paper provides back-
ground, instruction, and additional suggestions for using the CalPro program. The
examples contain detailed instructions for each step. If you are new to CalPro, it
will be useful to run these examples while reading the paper.

What Is CalPro?

CaPro isacomputer program meant to predict the development of mixed-conifer
standsin California. With this program, various management regimes can be
considered, and their outcomes can be quickly predicted. Three relatives of CalPro
(NorthPro, WestPro, and SouthPro) already exist for northern hardwoods in
Wisconsin and Michigan (Liang et a. 2004), for Douglas-fir (Pseudotsuga
menziesii (Mirb.) Franco) in the Pacific Northwest region of the United States
(Ralston et a. 2003), and for loblolly pine (Pinustaeda L.) in the Southern United
States (Schulte et a. 1998), respectively. We have used our experience with these
programs to further simplify the data input and the program output to maximize
CaPro’s usefulness for practitioners.

Why Simulate This Type of Stand?

Mixed-conifer forests compose one of the largest vegetation typesin California,
covering 13 percent of the state's area (Barbour and Major 1977). The expansive-
ness of the mixed-conifer types and the amount of timber harvested from the west
slopes of the Sierra Nevada M ountains emphasize the need for accurate growth-
and-yield prediction methods applicable to mixed-conifer stands. Uneven-aged
management, selecting single trees or small groups of trees at intervals of 5to 20
years and encouraging natural regeneration, helps maintain a continuous tree cover
with aesthetic and ecological benefits (DeBell and Franklin 1987). Some of the
examplesin this manual also suggest that effective uneven-aged management of
mixed conifers can be profitable. CalPro helps foresters predict how a given
forest stand might look in the future and what it could yield under uneven-aged
management.
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How Does CalPro Work?

CalPro predictions are based on a multispecies, site- and density-dependent matrix
growth model for California,* an extension of earlier density-dependent matrix
models (Lu and Buongiorno 1993). The data used to calibrate the growth model
came from plots remeasured in two surveys in the 1980s and 1990s in forest stands
in the Sierra Nevada Mountains (app. 1).

The equations built in CalPro predict growth, mortality, and the rate of
ingrowth (recruitment) for hardwood and softwood species. The model equations
arein appendix 2.

What Is in This Manual?

The next section explains how to install CalPro on your computer and provides a
description of the input data, as well as instructions for loading and saving these
data, running simulations, and saving the results. Two examples of applications are
given. We included answers to some common questions. The manual assumes that
you are familiar with the basics of Microsoft Excel.

2. Getting Started
System Requirements

You need the following hardware and software to operate Cal Pro:

e A computer (PC) with at least 16 megabytes of randomzacce& memory (RAM)

*  Windows® 95, 98, 2000, Me, XP, or Windows NT™ 4

* Microsoft Excel 5.0 to Excel 2002

» A free copy of the CalPro software downloaded from
http://forest.wisc.edu/facstaff/buongiorno/index.htm or from the authors
through jbuongio@wisc.edu.

Installing CalPro

To install the program for the first time:

1. Insert the diskette containing CalPro.xlainto your computer, or download it
from the Web site to your local disk and go to step 3.

2. Select the CalPro.xlaicon and copy it onto your hard disk. For your conven-
ience, you may saveit in anew folder named CalPro, e.g.,
C:\CaPro\CalPro.xla.

! Liang, J.J.; Buongiorno, J.; Monserud, R.A. Estimation and application of a growth and
yield model for uneven-aged mixed conifer standsin California. Forest Ecology and
Management. Manuscript in preparation. On file with: R. Monserud, Pacific Northwest
Research Station, 620 SW Main St., Suite 400, Portland, OR 97205.

2 The use of trade or firm names in this publication is for reader information and does not
imply endorsement by the U.S. Department of Agriculture of any product or service.
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3. Open Microsoft Excel and START A NEW WORKBOOK .

4. Under the Tools menu, select Add-ins. In the add-ins dialogue box, select
Browse and choose CalPro.xla from its location on your hard disk. Click OK.

5. Return to the Tools menu and notice that CalPro is now the last choice in the
menu. Select CalPro and click OK in the title box.

6. The CalPro menu should now be in the Excel menu bar.

Until you uninstall it, CalPro will be a permanent option in the Tools menu of
Excel. Clicking on the name CalPro in the Tools menu adds CalPro to the Excel
menu and makes the input data worksheet (fig. 1) appear.

E3 Microsoft Excel - Book1

DRy @R Y B v @ = -4 illex ~-& 2 A ~vosB rulEEEE

Al - f

A | 8B | ¢ | b | E | F | & | H | 1 | 4] K L [ m | N] o ]| P

1 1
2 " 3 —
X <~ CalPro
- — CalPro
5
ESD[IM
_7_ DBH class [inches] [] 6 8 10 12 14 16 18 20 22 24 26 28 30 32 EL] 36 38 40+
8 Initial state (treestacre) ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ?
| 3 | Target state (eestacre ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ?)
10 | Stumpage prices ($tvok ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ?
1 tcord  $icord $icord  $lcord  $IMbE IMbi IMbi IMbi IMbi MbE Mbi IMbi MBI IMbi IMbi IMbi IMbE IMbE IMbE
| 12 Hardwoods
|13 | DBH class {inches) [] 3 [] 10 12 14 16 18 20 22 24 26 28 EI] EF] L] 36 ] 40+
14 | Initial state (treestacre) ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ?
15 | Target state (treestacre ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ? ?
| 16 | Stumpage prices [$ivol ? 7 7 ? ¥ El ? ? ? ? ? L ? ? ? ? ? ? ?
17 tcord 1d_$icord $icord $IMbi IMbi IMbi IMbi IMbi IMbE IMbi__ $/Mbi_ $I/Mbi__$IMbi__ $IMbi IMbi IMbi__ $IMbi__ $IMbF
18
E Year of first harvest ?
20 | Length of cutting cycle 7 years
| 21 Length of simulation ? years
22 | Re-entry Cost 7 $lacre
23 | Interest rate ? Hlyear
| 24 | Site Index ? ftat age 50
25
26|
127
|28
29
30
31
32 |
£
34
35
| 35
| 37
EN
E
40
41
42
44 b4
M 4 » M \Input Data { Sheetl [ Sheet? [ Sheet3 |4] |L|JJ

Figure 1—Input Data worksheet.
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There are five sample workbooks at our Web site with the input data
worksheets corresponding to the examplesin section 4 of this paper. By copying
the data from these worksheets into your input data worksheet you will be able to
run these examples with Cal Pro.

Uninstalling CalPro

To remove the CalPro menu and uninstall the program:

1. Closeal Excel windows.

2. Select thefile CalPro.xlaand delete it from your hard disk.

3. Open Microsoft Excel and start a new workbook.

4, Under the Tools menu, select Add-ins. Deselect CalPro to remove thetitle
from the add-inslist.

5. Close the Excel window.

3. Using CalPro

CalPro Input

In the input data worksheet (fig. 1), each cell with a question mark requires a
numeric entry. CalPro automatically converts numeric entries to one or two deci-
mal places.

Infigure 1, the two rows labeled “initial state” contain the initial number of
trees per acre in the stand (at time zero), by species groups and by 2-in diameter
classes. CalPro recognizes two species groups, hardwoods and softwoods (app. 1).

The two rows labeled “tar get state” contain the number of trees per acre, by
species group and by diameter class that should remain after harvest. A target entry
of zero instructs CalPro to harvest all treesin that species category and diameter
class. When the number of treesin the stand exceeds the target value, the harvest
is the difference between the available trees and the target; otherwise the harvest is
zero. You can always prevent the removal of any tree by entering a very high target,
e.g., 1,000.

The datain the rows labeled “ Sumpage prices’ arein dollars per cord (1 cord
=128 ft3) for trees of pole size. They are in dollars per thousand board feet (MBF)
for trees of sawtimber size.

CalPro measurestimein years. All simulations start at time zero and last for
the “Length of simulation.” The“Year of first harvest” may be set at any
nonnegative value. The “L ength of cutting cycle,” i.e, the interval between
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harvests, must be at least 1 year. To simulate stand growth without harvest, set the
“Year of first harvest” to avalue greater than the “Length of simulation.”

The“Re-entry Cost” represents cost of doing a harvest, in dollars per acre,
independent of the volume harvested. The cost of timber sale preparation and
administration would be part of atypical re-entry cost.

The“SiteIndex” is measured by the average total height of the dominant and
codominant trees at 50 years of age (Hanson et a. 2002). The site index should be
between 30 and 99, the range of site-index values on the plots used to calibrate
CaPro.

CalPro treats empty input data cells as errors and will prompt you to fix them.
You can enter zeros for Sumpage prices, Re-entry Cost, and I nterest rateif you
do not want afinancial analysis.

BDq Calculator

A BDq distribution is atree distribution, by diameter class, defined by a stand basal
area (B), amaximum and minimum tree diameter (D), and a g-ratio (q), the ratio of
the number of treesin agiven diameter class to the number of treesin the next
larger class. You can use the BDq calculator to define either the target state or the
initial state with a BDq distribution.

To use the BDq calculator, click on the BDq calculator icon in the input data
worksheet. Use the arrow buttons to set the stand basal area (ftzlac), the g-ratio, the
minimum and the maximum diameters (in); click the Calculate button (fig. 2).

The example in figure 2 shows the number of trees by diameter class that
would give abasal area of 90 ft'/ac with trees of diameters from 3 to 40 in and a
g-ratio of 1.7. You can copy the resulting stand distribution to the input data
worksheet astheinitial distribution or as the target distribution for a species group
by selecting the destination and clicking the Copy button on the BDq cal culator

(fig. 2).
BDq Distribution Calculator 2]

Basal Area: Maxirmism Dismeter: Minimurm Diameter:

(sqftjace) 90 | (inches) 40+ 2| gratic 1.7 2] (nches) 2= [ caleutate | cancel |
.;rmsiwabrsizedass . : =

4 & 8 10 12 14 16 18 20 22 24 25 28 30 32 34 36 38 40

111,72 65,722 | 38.660 | 22.741 [ 13.377 | 7.8690 | s.6288 | 2.7228 | 1.6016 [ 0:9421 [0.5542 |0.3260 | 0.1917 | 0.1128 | 0.0863 [ 0.0390 [ 0.0229 | 0.0135 | 0.0073 |
Copy to Input Data worksheet as:

Softwoods: Hardwoods:
" Iritial Distribution " Initial Distribution Copy
 srget trbution] € TorgetDistribution

Figure 2—The BDq Distribution Calculator window.
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Storing Data and Retrieving Stored Data

After entering datain the I nput Data worksheet, you can save this worksheet for
later use. You should save your work frequently to avoid losing data. It is advisable
to save the work in a particular folder to facilitate locating the file in the future.

To run several simulations, e.g., to examine the effects of changing some of the
parameters, you may find it efficient to work with previously saved input data. To
retrieve the data, choose the File->Open command in Excel to open your saved file
or double click on thefileicon.

Running Simulations

After completing the input data worksheet or retrieving a previously saved one, you

are ready to run asimulation. To run CalPro, make sure that the CalPro menuisin

the Excel menu bar. If not, click CalPro under the Tools menu to activate CalPro.

You can then run the simulation by choosing Run in the CalPro menu.
Each CalPro simulation generates the following worksheets and charts:

» A TreesPer Acre worksheet: The number of trees by species and diameter
classfor each simulated year.

* A Basal Areaworksheet: The basal area by species and diameter class, for
each simulated year.

* A Products worksheet: The physical output and the financial return from the
harvests throughout the simulation.

» A Diversity worksheet: Shannon’s species diversity indices and size diversity
indices for each year of the simulation.

* A Diversity chart: A plot of Shannon’sindices of species and size diversity
over time.

* A Species BA chart: A stacked area chart showing the devel opment of stand
basal area by species group over time.

* A Size BA chart: A stacked area chart showing the development of stand basal
area by timber size over time.

To compare various management regimes, save the output worksheets immediately

after running a simulation. Otherwise CalPro will overwrite the previous results

every time you run a new simulation.
All the data in the output worksheets are protected and you cannot change

them. To see how results change with different input data, change the input data

worksheet and rerun the simulation.
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Quitting CalPro

To finish working with CalPro, choose the command Quit under the CalPro menu.
The CalPro menu will then disappear, but the current worksheets will stay in the
Excel window until you close them.

4. Examples
Simulating the Lexen Stocking Standard

Bert Lexen developed a stocking standard for ponderosa pine (Pinus ponderosa
Dougl. ex Laws.) stands managed by selection (Alexander and Edminster 1976).
Based on his studies of space requirements of ponderosa pines of different sizes,
Lexen recommended aresidual basal area of about 98 ft?, distributed by diameter
classasintable 1, for lands of site index from 75 to 100. One possible interpreta-
tion of this approach is reflected by the target stand distribution shown in figure 3.
The abjective of this exampleisto apply CalPro to simulate the effect of applying
Lexen’s stocking standard.

Table 1—L exen’s growing stock for selection forests
of ponderosa pine

D.b.h. class Trees Basal area
Inches Number per acre Square feet per acre
2 105.4 2.29
4 71.0 6.20
6 48.0 9.50
8 324 11.31
10 21.8 11.89
12 14.8 11.62
14 10.0 10.69
16 6.8 9.49
18 45 7.99
20 31 6.72
22 21 5.44
24 14 4.40
Total 322.4 97.55
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Figure 3—Input data worksheet to simulate L exen regime.

Input data—

Theinitial stand state for this exampleisin figure 3. It corresponds to the average
distribution on the 21 plots (of 205 total used in calibrating CalPro) that were
dominated by ponderosa pine trees. Trees in each species group were assembled
into nineteen 2-in diameter classes ranging from 3 to 39+ in. Each classis denoted
by its midpoint diameter. For example, the 4-in class includes trees with a diameter
at breast height (d.b.h.) from 3 to 5 in. The 40+ in diameter class includes trees
39in and larger in d.b.h. Enter these data into the I nitial state rows of the input
data worksheet, softwood datainto cells B8 through T8 and hardwood data into
cells B14 through T14. In this example, you do not use the BDq calculator.

The target stand state is the proposed number of trees per acre in each diameter
class and species group after each harvest. We divided Lexen’s desired number of
trees per acre by species in proportion to the number of trees per acrein theinitial
stand state (88 percent for softwoods and 12 percent for hardwoods). Enter this
Target stateinto cells B9 through T9 for softwoods and B15 through T15 for
hardwoods.
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Enter the Stumpage pricesin cells B10 through T10 for softwoods and B16
through T16 for hardwoods. Enter the Re-entry Cost into cell B26, assumed to be
zero in the absence of timber sale preparation and administration.

Enter into cell B23 thereal I nterest rate of 3 percent per year, which isthe
projected return on the Treasury bonds in the Socia Security trust fund (USGPO
2004).

Next, enter in cell B19 the Year of first harvest, assumed here to be zero, the
beginning of thefirst year of the ssimulation.

Set the Length of cutting cycleto 20 yearsin B20 and set the L ength of
simulation in B21 to 200 to allow for 10 harvests.

Last, in cell B24, enter a Siteindex of 88, the average site index for the 21
California plots dominated by ponderosa pine trees.

Simulation output—
The simulation outcomes are displayed in tables and charts. They are located in the
same workbook as the input data worksheet.

TreesPer Acre worksheet—This worksheet (fig. 4) shows the number of trees per
acre, by species and tree diameter class, for each year of simulation under the
Lexen stocking standard and a 20-year cutting cycle. Scrolling to the right reveals
the trees-per-acre distribution for hardwood species. The underlined numbers
represent the year of harvest and the number of trees per acre just after the harvest.

Basal area worksheet—This worksheet (fig. 5) shows, for each simulated year, the
total stand basal area, the stand basal area by species group, and the stand basal
area by timber size category: poles (treesfrom 5to 11 in d.b.h.), small sawtimber
(treesfrom 11 to 15 in d.b.h.), medium sawtimber (treesfrom 15to 21 in d.b.h.),
and large sawtimber (trees 21 in d.b.h. and larger). Underlined numbers show the
year of harvest and the basal areas just after harvest.

Products worksheet—The upper part of the products worksheet (fig. 6) shows data
for each harvest in terms of basal area cut, gross income, total net present value
(NPV), the pole and sawtimber volumes cut for each species group, and the annual
production in basal area and volume cut. The volumes are computed from equa-
tions linking tree volume to tree diameter, stand basal area, and site index (app. 2).
The lower part is acopy of theinput datafor reference only.
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36 27 54.3 36.4 28.4 221 16.3 1.9 5.9 4.0 26 18 09 0.3 0.1 -
W 4 » n|{ Diversity Chart [ Diversity / Basal Area ) TreesPerAcre / Products / InputData {Shaetl A Sheetz |« | | Lij_l

Figure 4—TreesPerAcre worksheet.
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'@ CalPro  File Edit View Inset Fomat Tools Data Window Help Type a question forhelp B2 & X
Ny Q@Y% & - @ = -4 jiooz 2 »: TmsRmn -10 -|[B]z © BH $% = _-b-A- 2
Al i f
A B [ c | D [ E [ F [ G | H ] ) E
1 File created by Jingjing Liang on 8/2/2004 ]|
| 2 | Length of cutting cycle 200 Site index 88.0
35| Length of simulation 2000
4
5 Small Medium Large
| 6 | Total Softwoods = Hardwoods Pole Sawtimber = Sawtimber Sawtimber
i D<1lin. 11zD<15 15:D<21 D>21in.
| & | Year Basal Area  (ft2/ac)
10 | 1 96.6 89.7 70 328 213 252 1.1
AR 2 99.7 92.8 7.0 331 219 26.2 12.2
[ 12 | 3 102.8 95.9 7.0 33.4 226 27.2 13.4
13 | 4 106.0 99.0 7.0 336 233 282 146
| 14 | 5 109.1 102.1 7.0 338 240 29.2 159
15 | 6 112.2 105.2 7.0 339 247 30.2 17.3
| 16 | 7 1153 108.4 7.0 34.0 25.4 3.2 18.7
[ 17 | 8 1185 1.5 7.0 34.1 26.0 32.2 201
| 186 | 9 1216 114.7 7.0 34.1 26.6 332 21.7
[ 19 | 10 124.8 117.8 69 341 272 342 232
| 20 | 1 127.9 1210 6.9 34.1 278 353 249
21 12 131.0 124.1 6.9 340 28.3 36.3 266
| 22 | 13 134.1 127.2 6.9 338 28.9 373 28.4
| 23 | 14 137.2 130.4 B39 337 29.3 383 30.2
| 24 | 15 140.3 1335 6.8 336 29.8 39.3 320
| 25 | 16 143.4 136.6 6.8 33.4 30.2 40.3 34.0
| 26 | 17 146.5 139.7 6.8 332 306 413 36.0
.27 | 18 149.6 142.8 6.8 329 0.9 42.3 38.0
| 26 | 19 162.6 1459 6.7 326 31.2 43.3 40.2
| 30 | 21 94.2 89.2 5.1 30.5 22.7 248 109
| 31 | 22 97.3 922 6.1 307 23.3 259 12.0
32 | 23 100.4 953 5.1 308 239 270 132
33| 24 1036 98.4 5.1 31.0 246 281 14.4
| 34 | 25 106.7 1015 5.1 311 26.2 293 16.7
| 35 | 26 109.8 104.7 52 31 %8 30.4 17.0
| 36 | 27 113.0 107.8 5.2 31.2 26.3 315 18.5 -
4 4« » wl{ Diversity Chart [ Diversity )Basal Area { TreesPerAcre [ Products Data / Sheet1 [ Sheet:|+| | LUJ
Figure 5—Basal Areaworksheet.
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Ed Miciozolt Excel - Lexen

‘@) CaPro Fle Edt Yiew [nset Fomat Jooks Data Wndow Help ype a question fot | e .8 %
DEEYy &A% @ o- @ =-5) 100z =3 2 TR -0 -[BlzU]E=EEEH 8 % E _-5-A- >
Al - fe Periodic Cut
A 8 (G | = | | O | O 0 00 0 0 O e O =

1 1 File created by Jingjing Liang on 6/2/2004 =
2 Year ] 20 10 60 80 100 120 140 160 180 200

'3 | Basal area [ft*/acre) 209 645 648 (21 632 63.2 632 632 632 §3.2 633

| 4 Softwoods sawtimber (ft*/a) 708 18334 18709 185901 18567 18580 18595 18607 18616 18622 18626

| 5 |Softwoods pole {ft%/a) 454 0.0 00 0.0 0.0 00 00 00 00 0.0 00

6 |Hardwoods sawtimber (ft*/a) £46 03 9.1 204 153 125 112 105 100 LT3 93

7 Hardwoods pole {ft*/a) 4 45 11 00 00 0.0 00 00 00 0.0 (1]

| B Gross income ($/acte) 46408 107946 109164 108074 107779 10FPR1 107826 107677 107313 107937 107952

‘9 |Net present value ($/acte) 464077 597672 334649 183437 101288 S60.76 31064 17207 95.31 52.78 9.3

10 Total NPV [$/acre) 18032.02

11

| 13 Basal area 3.3 (ft*fafyr)

14 Softwoods sawtimber 96.6 (ft*/afyr)

15 Softwoods pole 0.2 {ft*/ajyr)

| 16 | Hardwoods sawtimber 1.2 (ft*fafyr)

17 Hardwoods pole 0.1 (ft3/ajyr)
| 18 Total Yolume 98.08 (ft3/a/yr)

19
&l

21

n | 3.

23 [DBH class (inches) [ 6 [ 10 12 14 16 18 20 i ] 26
| 24 Inifial state (ees/acre) 7438 546 336 202 122 95 8.2 5.1 29 21 19 12
| 35 | Target state (rees/acre) 576 412 308 04 136 100 6.4 45 a7 18 14 0.0

26 | Stumpage prices ($/volume) 1.1 12.17 12.17 255.44 386.00 386.00 490,00 490.00 490.00 490.00 490.0 490,00
(27| Sheord Sleard $leaed b STV St SIM SIh 1M SV SV ShH $
28 Hardwoods

29 |DEH class (inches) 1 6 3 10 12 14 16 18 10 11 ] O
| 30 | Tniial state (weesfacre) 174 90 L7 14 11 [0 04 00 04 04 [ [

31 Target state (rees/acre) 134 63 16 14 12 [ 04 0.0 04 03 1] 0.0

| 32 Stanpage prices ($/volume) 23 32.39 3239 123 35.00 35.00 35.00 35.00 35.00 35.00 30 35.00

S Sheord Steord $leand $1M $IM $IM SIbve S ST SiM §Ihve S $
=

o B St Dhversty  Basalfasa £ TrsesParfcrs ) Products { Trpik Dats J Shaetl {Shest |4 | -

Figure 6—Products workshest.
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The results show that with this particular initial stand state and with a 20-year
cutting cycle, the Lexen regime would produce a nearly constant periodic produc-
tion beginning in the 60" year. The average yield over 200 years would be 104.90
ft2sacleyr?, for anet present value of $13,506/ac. Thisis the value of the land and
initial trees under this management. It suggests that Lexen’s regime, with this
cutting cycle, would not be economically efficient. Because the value of theinitial
trees was $14,072/ac (this value is easily calculated from the data in the lower part
of the products worksheet), the present value of the return from land and initial
trees would be less than the initial investment in trees alone.

Diversity worksheet—The diversity worksheet (fig. 7) shows Shannon’s indices of
species group diversity and tree size diversity for each simulated year (see app. 3
for the definitions of Shannon’s diversity). The underlined data show the year of
harvest and the values of the diversity indices just after harvest.
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@ CalPro  File Edit  Yiew Insert Format  Tools Data  Window Help - & X
[ 2 - TmsRmn v1DvIg§§ _-&),é,?
Al i f*
A B [ € | o T | B = 3

1 File created by Jingjing Liang on 8/2/2004 3
2
| 3 |

4
[BSH Shannon's Shannon's
| B | Species Size

7 Diversity Diversity
| 8 | Year
El 0 0.26 236
| 10 | 1 0.26 239
|11 2 0.25 241
| 12 | 3 0.25 242
| 13| 4 0.24 2.44
| 14 | 5 0.24 2.45
| 15 | 6 0.23 247
| 16 | 7 0.23 2.48
| 17 | 8 0.22 2.49
| 18 | 9 0.22 251
| 19 | 10 0.21 252
| 20| 11 0.21 253
| 21 12 0.21 254
| 22| 13 0.20 255
1 23| 14 0.20 2.56
| 24 | 15 0.19 257
| 25| 16 0.19 258
| 26 | 17 0.19 260
| 27 | 18 0.18 281
| 25 | 19 0.18 262
25 2 0.21 236
| 30 | 21 0.21 239
| 31 | 22 0.21 2.40
| 32| 23 0.20 242
| 33 | 0.20 2.44

I?di b M Digeﬁrsit Chart Di\.l'ersiE.1 Basal Area JLI_I 2 LIJ_‘

Figure 7—Diversity worksheet.

Diversity chart—The diversity chart (fig. 8) displays the evolution of Shannon’'s
indices over time. The results show that the Lexen regime with a 20-year cutting
cycle would lead to a sharp decrease of size diversity and increase of species
diversity right after each harvest. Both diversity indices would recover to about
their initial level by the time of the next harvest.

Species basal area chart—This chart (fig. 9) shows the development of basal area
by species throughout the simulation period. The chart suggests that, with a 20-year
cutting cycle, the Lexen regime would lead to a 50-percent decrease in the basal
area of softwoods after each harvest, but to little change in the basal area of

13
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Figure 8—Diversity chart.
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hardwoods. The basal area of softwoods would recover almost totally in 20 years,
while the hardwood component remains essentially constant.

Timber size basal area chart—This chart (fig. 10) shows the development of basal
area by timber size throughout the simulation of the Lexen regime. It excludes the
basal area of trees smaller than poles, which have a minimum diameter of 5in. The
results suggest that the basal area of poles would gradually decrease over the first
80 years and then stabilize. The basal area of sawtimber—Ilarge, medium, and
small—is reduced heavily in each 20-year cutting cycle, with each cycle essentially
the same after about 80 years.

Type a question for heip (S REEIESCH

] Fle Edt View [met Fomst Jook Chat Window Hep

I DSER SRY B - @& -4 i = ezl e s EmsHE S % E[ S-S A 7
> il
Olarge Sawtimber
Stand Basal Area by Timber Size O Medium Sawtimber
| Small Sawtimber

160.0 1BA (PacT)

o

@Pole

140.0 4

1200 4

444’4 444

B0.0 4

400

mno

oo

o 2 40 2] 1] 100 120 140 160 180 200
Year
|4 % W\ Speces 8 Chart ), Size BA Chart / Diversky Chart [ Diversity { Basal Area { TressPescre ] Products [ Input Data { Sheetl [ Sheet2 [ Sheet3 /
Figure 10—Size BA chart.

Simulating BDg and Diameter-Limit Management Regimes

In this example, we performed a series of simulations on two kinds of cutting
regimes:. basal-area-diameter-g-ratio (BDq) selection and diameter-limit cut. We
then compared the results in terms of economic returns, productivity, tree diversity,
and stand structure.

15
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Simulation parameter s—

The simulations were for 200 years with cutting cycles of 20 years. The initia
stand state was the average distribution of the 205 plots used in calibrating the
growth equations of CalPro. The average site index was 88 ft. Softwood trees
composed 88 percent of the stand initial basal area, and hardwood trees composed
12 percent. The interest rate was set at 3 percent per year, in real terms (net of
inflation). The prices used are in table 2.

For the BDq regimes, the residual stand basal areawas set at 91 ftzlac,

74 ftzlac, or 61 ftzlac, corresponding to alight, medium, or heavy selection. The
g-ratio was 1.40, the average value on the 205 plots.

Figure 11 shows the BDq calculator set to produce the target state for softwood
trees according to a light selection. Setting the basal areato 80 reflects the fact that
88 percent of the initial stand is composed of softwood trees (91 ft' x .88 = 80 ftz).
Set the g-ratio to 1.40, the maximum diameter limit to 40+, and the minimum diam-
eter limit to 3. Click on the Calculate button. The BDq calculator produces the
number of trees by size class.

To copy the distribution to the input data worksheet, select the option box
corresponding to Softwood Tar get Distribution and click on the Copy button.

Repeat these steps for the Har dwood Tar get Distribution, using abasal area
of 11 ft’.

The diameter limits were set at:

10 in (cut all sawtimber trees), or
16 in (cut medium and large sawtimber trees), or
22 in (cut only large sawtimber trees).

Figures 12 and 13 show the input data worksheet for the light BDq selection
regime and the 10-in diameter-limit cutting regime, respectively. The two spread-
sheets differ only by the number of treesin the target states.

Running simulations—

To run aseries of simulations, load the input data for the first management regime,
run the ssimulation, save your outcome, and proceed to load and run the second
management regime.

Upon running a simulation, CalPro will replace any old tables and charts with
new ones. For this reason, you should save the workbook after each simulation.
You can then compare the data on NV P, basal area, number of trees, diversity of
species and size, and volume production for different regimes. To that end, com-
parative charts and tables can be built with Excel from the CalPro output
worksheets.
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Table 2—Target distribution for BDq selection regimes

BDq selection
Species Timber size D.b.h. Sumpage pricea Light Medium Heavy

Inches  $icord”  $IMBF°  ————Trees per acre————
Softwoods 4 11.11 37.3 30.3 25.2
Pole 6 17.77 26.7 21.7 18.0
8 17.77 19.0 155 12.9
Sawtimber 10 255.44 13.6 111 9.2
12 386.00 9.7 7.9 6.6
14 386.00 6.9 5.6 4.7
16 490.00 5.0 4.0 3.3
18 490.00 35 29 24
20 490.00 25 2.1 17
22 490.00 18 15 12
24 490.00 13 1.0 9
26 490.00 9 T .6
28 490.00 7 5 A4
30 490.00 5 4 3
32 490.00 3 3 2
34 490.00 2 2 2
36 490.00 2 1 1
38 490.00 1 1 1
40+ 490.00 1 1 1
Hardwoods 4 32.39 51 4.2 3.3
Pole 6 32.39 3.7 3.0 2.3
8 32.39 2.6 2.1 17
Sawtimber 10 32.39 1.9 15 12
12 35.00 13 11 9
14 35.00 1.0 8 6
16 35.00 7 6 A4
18 35.00 5 4 3
20 35.00 3 3 2
22 35.00 2 2 2
24 35.00 2 1 1
26 35.00 1 1 1
28 35.00 1 1 1

30 35.00 A 1 0

32 35.00 0 0 0

34 35.00 0 0 0

36 35.00 0 0 0

38 35.00 0 0 0

40+ 35.00 0 0 0

@ Unit values are adapted from California State Board of Equalization (2003), Harvest values schedule, effective July
1, 2003, through December 31, 2003.

51 cord = 128 fts.
¢ MBF = 1,000 board feet.

17



GENERAL TECHNICAL REPORT PNW-GTR-619

BDgq Distribution Calculator

?ﬁﬂfﬁé; s 2 mmw ~m+§! Qratio 1.4 = cmm“* 3 = Calculate | cancel |
Treesfacre by size class
4 ] & 10 12 14 16 18 20 22 24 26 28 30 3z 34 36 36 40
37,335 | 26.668 | 19.048 | 13.606 [0.7188 | 6.9420 | 4.9585 | 3,541 | 2.5298 | 1.8070 | 1.2907 | 0.9215 [0.6585 | 0.4703 [ 0,335 [0.2392 | 0.1714 | 0.1224 [ 0.0874 |
Copy to Input Data worksheet as:
Softwoods: Hardwoods:
C Initial Distribution  Initial Distribution

' Target Distribution € Target Distribution

Figure 11—BDq Distribution calculation dialog box.

E3 Microsoft Excel - Light BDq

;fb Edt View |nset Fomat Took Data ‘Window Help Type a question for help
DNy QLY B v @ = -4] {1100 -3 2 A -0 - B I UEEEE % E _-H-A- 2
Al - 3
A | B C|OD|EJF|G|H[I]J[K]JLIM|INJOJPJQ|RI[S|TIU] *Fg
1 1 —|
._.2_ = g 1 . P, |
4 | Input Data _a B
KN
B | Softwoods
7 | DBH class (inches) 1 6 8 10 12 14 16 18 20 22 24 26 28 30 32 34 36 38 40+
| B |Initial state {treeslacre) 7350 4290 2590 1690 1220 900 620 500 370 250 210 160 110 080 070 040 030 020 070
| 9 |Target state (treeslacre) 3734 2667 1905 1361 972 694 4% 354 253 181 129 092 066 047 034 024 017 012 009
| 10 | Stampage prices ($ivolume)  11.11 17.77 17.77 25544 386,00 32600 490.00 490.00 490.00 49000 490.00 490.00 490.00 49000 490.00 490.00 490,00 490.00 490.00
1" $lcord $lcord Slcord Slcord SIMbE SIMbE SIMbE SIMbE SIMbE SIMbE SIMbi SIMbE  SIMbE SJEM S$IMbE SIMbE SIMbE SIMbE SIMbE
| 12 | Hardwoods
13  DBH class {inches) L 6 8 10 12 14 16 18 20 22 24 26 28 30 32 34 36 38 40+
| 14 | Initial state (treeslacre) 1960 1120 550 220 170 130 050 050 040 030 020 020 010 010 010 000 010 000 000
| 15 | Target state (treeslacre) 513 3467 262 187 134 085 068 049 035 025 018 013 009 006 005 003 002 o002 o001
| 16 | Stumpage prices ($ivolume) 3239 3239 3239 3239 3500 3500 3500 3500 3500 3500 3500 3500 3500 3500 3500 3500 3500 3500 3500
17 $lcord $lcord Slcord Slcord $IMbE SIMbE SIMbE SIMbE SIMbE SIMbE SIMbE SIMbE SIMbE SIMbf SIMbE SIMbE SIMbE SIMbE SIMbE
18
| 19 | Year of first harvest 0
| 20 | Length of cutting cycle 10 years
| 21 | Length of simulation 100 years
| 22 | Re-entry Cost 0 §facre
| 23 | Interest rate 3 %lyear
| 24 | Site Index 88 (age 50)
125 |
| 26 |
1 27 |
| 28 |
129 |
| 30 |
| 31 |
|32 |
33|
| 34 |
| 35 |
E b
W 4 v v/ Size BA Chart Chart Basal Area /| TreesPericre ,/ Products ) Input Data /| 4| | ,le

Figure 12—Input data worksheet for light BDq selection.
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EA Microszoft Excel - 10in _ &) x]
@] Fle Edt View Imet Fomet Took Deta Window Help Type & question for help  [RICEAIESE
Dy @R_AY & ©- @& = -2] il 100 -& » s -0 - B 7 U EFEEES % E _-S-A- 7
Al - §
| A B A e e R E e e N E e R R E EE EE |
1 1 ﬂ
El <CalPro™
| 4 Inpt Data E—— —
5
6 | sufiment
7 | DBH class (inches) 4 6 8 0 12 14 16 18 20 22 24 26 28 30 32 34 36 38 40+

| B Initial state (treeslacre) 7850 4290 2590 1690 1220 900 620 500 370 250 210 160 110 080 070 040 030 020 070
9 |Target state (treeslacre) 100000 100000 100000 100000 000 000 000 OO0 OO0 000 OO0 000 OO0 OO0 OO0 OO0 OO0 000 000
| 10 | Stompage prices (Shvokome) 1111 1777 17.77 255.44 386.00 386.00 430.00 430.00 430.00 490.00 430,00 430.00 430.00 430,00 430.00 430.00 430.00 490.00 490.00

11 Sleord Sleord  Sleord Sleord SIMbf $IMbE SIMbE SIMbE SIMBE SIMbE SIMbE SIMbE S/MbE SIMbE SIMbi SIMbE SIMBE SIMbE SIMbE
12 Hard
13 [DBH class (iches) A6 8 10 12 14 16 18 20 22 24 26 28 30 32 34 36 38 40v

| 14 | Initial state (treeslacre) 1960 1120 550 280 170 130 050 050 040 030 020 020 010 010 010 000 010 000 000
| 15 | Tavget state {treestacre) 100000 100000 100000 100000 000 000 000 000 000 000 000 000 000 000 000 000 000 000 000
| 16 | Stumpage prices (Sivolume) 3239 3239 3239 3239 35.00 3500 3500 3500 3500 3500 3500 35.00 3500 3500 3500 3500 3500 35.00 35.00

7 $lcord  $lcord  $lcord  $lcord $IMbE $IMbE $IMLE $IMbE $IMBE $IMb $IMBE $IMbE $IMbE $IMLE SIMbE $IMBE $IMbE $IMbE $IMbLE
18

19 Year of first harvest 0

20 Length of cutting cycle 10 years

| 21 | Length of simalation 100 years
22 Re-entry Cost 0 §/acre
| 23 | Interestrate 3 Xlyear
| 24 | Site Index 38 (age 50)
25|

| 26|

27 |

| 26|

| 29|

| 30 |

|31

|32

3

341

35

36

=

Figure 13—Input data worksheet for 10-in diameter-limit regime.

Simulation results—

For al six cutting regimes except the 22-in diameter-limit cut, after 200 years, the
stand basal area reached a near-homeostasis, where growth over a cutting cycle
generally replaced the harvest. For example, figure 14 shows how basal area by tree
size developed with the light BDq selection. The figure was generated by CaPro
(Size BA chart).

Figures 15 and 16 show comparative statistics on diversity and productivity
assembled from six simulation runs. Figure 15 shows that the three BDq selections
generated higher species and size diversity than the diameter-limits cuts. The data
were obtained from the diversity worksheet produced by CalPro.

4% ¥l\Input Data / <] {T_'—’_WM
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Figure 14—Development of stand basal ar
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Figure 15—Effect of management regime on tree diversity after 200 years.
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Figure 16—Net present value (NPV) and volumeyield of different cutting
regimes.

Figure 16 shows the NPV and yearly production of the different cutting
regimes over 200 years, with a 20-year cutting cycle. We built these figures from
the results in the Products worksheets of CalPro. The 10-in diameter-limit cut
yielded the highest NV P, whereas the 22-in diameter-limit cut gave the highest
annual production.

5. Troubleshooting CalPro
Why can’'t | open CalPro?

Make sure you have the latest copy of CalPro (2004). It should be 535K B in
size, and the file type should be Microsoft Excel Add-in.

How can | download CalPro from your Web site?

Visit our Web site: http://forest.wisc.edu/facstaff/buongiorno/index.htm.You
will find an icon of CalPro on the index page. Click on the icon, and you will be
directed to our Products page where you can see the links for the CalPro program
and some example worksheets. Right click on the link and save CalPro.xlato your
local disk.

CalPro does not insert a new input data worksheet. What can | do?

Before inserting a new input data worksheet, CalPro checksto seeif thereisa
worksheet named I nput Data aready open. If there is one, CalPro will not gener-
ate anew Input Data worksheet. To get a new input data worksheet, close all Excel
windows and reopen CalPro.

21
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Why is there no BDq calculator in the example wor ksheets?

The example workbooks contain only the input data. After you have installed
CalPro, the BDq calculator icon will appear in the new input data worksheet. At
that point, you can copy data from the example workbooks into the input data
worksheet.

Why is the BDq calculator not working?

CalPro must be open to use the BD( calculator. To use the BDq calculator on a
previously saved input data worksheet, CalPro must be in the Excel menu bar.

Why can’t | copy all the content from the example worksheet to the input data
wor ksheet?

All the cells of the input data worksheet are protected except those that need
entries (marked with ? marks). Copy only the data from the example worksheet and
paste them to the corresponding locations in the input data worksheet.

For further assistance, or to send us your comments, please visit our Web site
at http://forest.wisc.edu/facstaff/buongiorno/index.htm, or contact us through
jbuongio@wisc.edu.
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Metric Equivalents

When you know: Multiply by: To find:

Inches (in) 2.54 Centimeters (cm)

Feet (ft) .305 Meters (m)

Square feet (ft?) .093 Square meters (m?)

Square feet per acre (ft¥/ac) .2296 Square meters per hectare (m?/ha)
Cubic feet (ft3) .0283 Cubic meters (m®)
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Appendix 1—CalPro Data

The data to calibrate the model used by CalPro came from 205 permanent plots
measured during the last two Forest Inventory and Analysis (2000) surveys con-
ducted by the Portland Inventory and Economics Program of the Pacific Northwest
Research Station. The surveys were conducted in the 1980s and 1990s in forestsin
the Sierra Nevada Mountains; national forests and parks were not included in the
sample.

The plots were in the mixed-conifer forest type and in uneven-aged stands
(fewer than 70 percent of the trees differed by less than 30 yearsin age [Hiserote
and Waddell 2003]). Most of the plots were in northern California (fig. 17). About
70 percent of the plots were on industry lands, and 25 percent belonged to other
private owners.

Trees were grouped as softwoods and hardwoods, and into nineteen 2-in
diameter classes, from 3to 5 in up to 40 in and above. White fir (Abies concolor
(Gord. & Glend.) Lindl. ex Hildebr.), a shade-tolerant conifer, was the most
abundant softwood on the plots (table 3). The moderately shade-tolerant California
black oak (Quercus kelloggii Newberry) and canyon live oak (Quercus chrysolepis
Liebm.) were the most abundant hardwoods. Most plots were on lands with site
indexes between 50 and 80 ft.

Figure 17—Number of plots (205
total) per county used to calibrate
CalPro.
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Table 3—Average number of trees per acre by species on the plotsused to calibrate

CalPro

Scientific name’

Common name

First inventory

Second inventory

Softwood:
Abies concolor
Libocedrus decurrens
Pseudotsuga menziesii
Pinus ponderosa
Pinus lambertiana
Pinus jeffreyii
Abies magnifica
Pinus contorta
Juniperus occidentalis
Taxus brevifolia
Pinus monticola
Pinus coulteri
Pinus attenuata
Sequoia gigantea
Torreya californica
Pinus sabiniana
Pinus albicaulis
Pseudotsuga macrocarpa
Abies magnifica v. shastensis

Total

Hardwood:
Quercus kelloggii
Quercus chrysolepis
Acer macrophyllum
Lithocar pus densiflorus
Arbutus menziesii
Umbellularia californica
Cornus nuttallii
Quercus wislizeni
Alnus rhombifolia
Alnusrubra
Castanopsis chrysophylla
Quercus garryana
Salix spp.
Quercus lobata
Populus tremul oides

Total

White fir
Incense-cedar
Douglasfir
Ponderosa pine
Sugar pine

Jeffrey pine
Californiared fir
Lodgepole pine
Western juniper
Pacific yew
Western white pine
Coulter pine
Knobcone pine
Giant sequoia
California-nutmeg
Gray pine
Whitebark pine
Bigcone Douglas-fir
Shasta red fir

California black oak
Canyon live oak
Bigleaf maple
Tanoak

Pacific madrone
California-laurel
Pacific dogwood
Interior live oak
White alder

Red alder

Golden chinkapin
Oregon white oak
Willow

California white oak

Quaking aspen

61.76 66.33
44.17 51.97
43.15 49.21
28.92 29.85
9.93 10.94
5.00 5.85
3.40 5.29
1.08 91
.35 35
44 .28
.28 .28
22 22
.26 14
A3 A3
.09 .09
.02 .02
.01 .01
01 .01

0 0
199.23 221.87
18.70 18.21
11.10 12.44
261 5.04
312 4.68
141 2.66
1.17 1.74
0 1.64
.60 1.56
.70 .80
.25 37
21 21
A2 A2
.05 .05
.02 .02

.04 0
40.11 49.54

aNomenclature per Little (1979).
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Appendix 2—Growth-and-Yield Model

The growth model used in WestPro (Ralston et al. 2003) has the following form
(Liang et al. 2004):

Yt+1 =G(yt —ht) +R, 1)

where Yt =[Y; jt] is a column vector representing the number of live trees per
acre of speciesgroupi (i = 1,2), diameter classj (j = 1,2,...,19) at timet. The
harvest column vector Nt = [hjjt] represents the number of trees of speciesi,
diameter classj that are cut at timet. G, the state-dependent growth matrix, de-
scribes how uncut trees grow or die between t and t+1 year. The state-dependent
vector R represents the number of trees recruited in the smallest diameter class of
each species group, betweent and t+1. G and R are defined as:

ra, ,
G, ) b, ‘?‘iz
G= G G, = .
’ b &
i B @,
R
[Rl} 0
R = , R, =| .
R, :
0

where 3, is the probability that atree of speciesi and diameter class| stays alive
and in the same diameter class between t and t+1, bij isthe probability that it stays
alive and grows up to diameter classj+1, and R isthe number of trees of speciesi
recruited in the smallest diameter class between t and t+1.

The staying rate, a;, isrelated to the upgrowth rate, bij, and the mortality rate,
m, by:

ajj =1-bj —mj;.
The expected annual upgrowth rate was calculated as:

hj=l

49
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whered = 2 in isthe width of each diameter class, and g, is the expected annual
diameter growth of atree of speciesi and diameter class|. The equation of the
expected annual diameter growth, for softwoodsis:

b, = exp(-7.07 + 2.99InD, - 0.52(1nD)’ - 0.261nB + 0.581nS)

and for hardwoods:
sz = exp(5.69 + O.641nDJ. - O.ll(lnDJ.)2 - 0.011nB + 0.481n9) ,

where D, isthe average tree diameter in diameter classj, B isthe stand basal area, S
isthe site index, and In(x) is the natural logarithm of x.

The expected annual mortality rateis given by:

1
mj = =Mij,

where M, is the expected mortality rate between two inventories, and T =10.88
yr is the average time between inventories in the sample. The equation of M, for
softwoodsis:

M, = @ (-0.148D, + 0.0026D].2 +0.005B + 0.238T - 3.141) ,

and for hardwoods:
le. =0 (-0.138D]. + 0.002D].2 +0.357T - 3.268) ,
where @ is the standard normal cumulative distribution.
The equation for the expected annual recruitment per acreis:
Ru =@ (B| X / Gi) Bi X+ Gi(p(Bixi / O-i) '
where ¢ isthe standard normal density function, and for softwoods:

B,x, =-0.035B + 0.018N + 4.266 and 5, = 5.703,



whereas for hardwoods;

B,x, = -0.023B + 0.058N - 7.379 and 5, = 8.69.

The expected volume of individual trees, in cubic feet, is calculated with the
following equations. For softwoods:

v, = exp(2.71InDj +0.026InB + 0.209InS - 5.079)

and for hardwoods:

v, = exp(2.518InDJ. +0.139InB + 0.283InS - 5.371).

For poletimber, the cubic-foot volume is converted to cords (1 cord = 128 ft%). For
sawtimber, the cubic-foot volume is converted to thousand board feet Scribner log
rule, with the conversion factorsin table 4 (Schmidt 1998).

CalPro: A Spreadsheet Program for the Management of California Mixed-Conifer Stands

Table 4—Scribner rule conversion factors

D.b.h. Softwoods Hardwoods
Inches Thousand board feet per cubic foot
9.0-10.9 0.783 —
11.0-12.9 .829 0.832
13.0-14.9 .858 .861
15.0-16.9 .878 .883
17.0-18.9 .895 .900
19.0-20.9 .908 913
21.0-22.9 917 .924
23.0-24.9 .924 .933
25.0-26.9 .930 .940
27.0-28.9 .932 .945
29.0+ .936 .954
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Appendix 3—Definition of Diversity of Tree Species and
Size
CalPro uses Shannon’s index to measure the stand diversity in terms of tree species
(how well trees are distributed across species class) and timber size classes. CalPro
measures the presence of treesin a class by their basal area, which gives more
weight to larger trees.

The tree species diversity is defined in CalPro as:

wherey isthe basal area of trees of speciesi per acre, y istotal basa area, and 1n
(x) isthe natural logarithm of x. In CalPro, m = 2 (softwood and hardwood). The
tree species diversity reaches a maximum value of In(2) = 0.69, when basal areais
equally distributed in both species groups, and a minimum value of zero when all
trees are in the same species group.

Similarly, tree size diversity is:

_ Vi Y
=333
where, again, Y, isthe basal area of treesin diameter class | per acre, y istotal basal
area, and 1n (x) isthe natural logarithm of x. In CalPro, n = 19 diameter classes.
The tree size diversity reaches a maximum In(19) = 2.94 when basal areais equally
distributed in al 19 diameter classes, and a minimum of zero when all treesarein a
single diameter class.
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Glossary

BA chart—A CalPro-generated chart showing, for a selected range of years, the
per-acre basal area of softwoods, hardwoods, and the whol e stand.

BDq distribution—A tree distribution, by diameter class, defined by a stand basal
area (B), amaximum and minimum tree diameter (D), and a g-ratio (q), the
ratio of the number of treesin agiven diameter class to the number of treesin
the next larger class.

cutting cycle—The number of years between successive harvests. For two-cut
silvicultural systems, thisis also equal to the number of years between succes-
sive harvests.

diameter class—One of nineteen 2-in diameter at breast height (d.b.h.) categories
used by CalPro to classify trees by size. Diameter classes range from 4 to 40+
in, with each class denoted by its midpoint diameter. Diameter class 4 isfor
trees with diameters from 3 to lessthan 5 in. The 40+ in classisfor al trees
39inin diameter and larger.

diversity chart—A CalPro-generated chart showing changes in the Shannon index
of species or size diversity over a selected range of years.

har dwood—See species groups.

initial stand state—The number of live trees per acre, by species and size, at the
start of asimulation.

input data wor ksheet—A worksheet to enter the data for running a CalPro
simulation.

Microsoft Excel add-in—A command, function, or software program that runs
within Microsoft Excel and adds special capabilities. CalPro is an add-in.

net present value (NPV)—The net revenue discounted to the present.

pole-size trees—Trees suitable for the production of poletimber but too small to
produce saw logs. In CalPro, these include trees from 5 to less than 11 in.

preharvest stand state—The number of live trees per acre, by species and size,
immediately before a harvest.

products wor ksheet—A CalPro output worksheet that shows, for each harvest, the
basal area cut, the volume of poles and sawtimber removed by species group,
the gross income generated, and the NPV of the harvest, as well asthe total
NPV of the stand and its mean annual production in terms of basal area cut and
volumes harvested, on a per-acre basis.

re-entry costs—Costs per acre associated with each harvest that are not reflected
in the stumpage prices. These may include, e.g., the added expense of marking
the stand for single-tree selection or controlling hardwood competition.
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sawtimber—Trees suitable for the production of saw logs. CalPro’s marking
guides recognize three classes of sawtimber trees:

(1) Small sawtimber—Trees with d.b.h. of 11 to lessthan 15 in.
(2) Medium sawtimber—Trees with d.b.h. of 15to lessthan 21 in.
(3) Large sawtimber—Trees with d.b.h. of 21 in or larger.

Setup File worksheet—A worksheet to store CalPro setup files. It istypically
hidden.

Setup Files—Collections of related input data that are stored together on a Setup
File worksheet. Setup Files may contain data for initial stand states, target
stand states, cutting cycle parameters, stumpage prices, or fixed costs, and may
be used in varying combinations as input for CalPro simulations.

siteindex—The average height of a stand’s dominant and codominant trees at age
50 years.

size diversity—The diversity of tree diameter classes as measured by the Shannon
index. With 19 diameter classes, size diversity reaches its maximum value of
2.94 when the basal area or number of trees is distributed evenly among the
diameter classes.

softwood —See species groups.

species diver sity—The diversity of species groups as measured by the Shannon
index. With two species classes, species diversity reaches its maximum value
of 0.69 when the basal area or number of trees is distributed evenly among the
Species groups.

species groups—The two categories used by CalPro to classify trees by species.
softwoods—Wood from Gymnospermae, mostly coniferous species such as

pine or fir.
hardwoods—Wood from Angiospermae, mostly broad-leaved dicotyledonous
Species.

stumpage prices—Prices paid to a landowner for standing timber.

target stand state—The desired number of live trees per acre in each species
group and diameter class after a harvest.

total net present value—The sum of al discounted revenues minus the sum of all
discounted costs.

wor kbook—The workbook is the normal document or file type in Microsoft Excel.
A workbook is the electronic equivalent of athree-ring binder. Inside work-
books you will find sheets, such as worksheets and chart sheets.

wor ksheet—Most of the work you do in Excel will be on aworksheet. A
worksheet is agrid of rows and columns. Each cell is the intersection of arow
and a column and has a unique address, or reference.
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